Basics Lesson Five - Internet Essentials

The World Wide Web (www) is synonymous with the modern Internet

The Internet started out as a black-screened, text-based way for the government and educational
institutions to communicate quickly over vast distances. When the Internet was transformed by
adopting a graphical environment (meaning it uses pictures and clicking on text for navigating,
instead of needing the knowhow to type text commands in order to do something), it became easy
to use. It was then it became known as the World Wide Web or WWW.

Often abbreviated as WWW, it has previously been humorously and historically described as short
for World Wide Wait. That wait was because of a combination of the wait required for a slow
dialup connection, plus overloaded web activity. This has been mostly resolved by “Broadband”
(cable, satellite, DSL, or optic) connections as well as servers (the computers which maintain all the
web page information) with larger capacity (the ability to handle more connections at once).

What makes the Internet so attractive and addictive?

The Internet offers an expansive base of information.
O You can obtain vast amounts of computer help, technical information (even user manuals

for most electronics, appliances, and just about any other device or entity), educational
material, and entertainment (music, videos, and games).
= You can even find the menu for your favorite “chain” restaurant, or the current
showings and times at the local theater.
= For computer help, just put part (or all) the error message into the search line, or
enter the file name giving a problem; or enter the term you wish explained, into a
search engine, such as Google (www.google.com), Bing (www.bing.com, or Yahoo
(www.yahoo.com . You will be amazed at the references that can be found.
= For technical information or “How to” instructions, insert the product or device into
the search engine, and add “manual” or “tutorial” or “review”. Or go to the
manufacturer’s home page (usually the manufacturer name followed by .com) and
look for support.
There are abundant Self-Help sites available.
Manufacturer’s product information, access to customer service, technical help, and even
user manuals are frequently obtainable.
= Forinstance, download a camera or electronic equipment manual. They are easier
to read than those often tiny, “impossible to keep your place” booklets.
Medical sites are accessible and medical advice available.
Cooking help or recipes can be found.
Newspapers around the world are available online.
= Keep in touch with hometown news from anywhere in the world.
The Internet also offers entertainment. Music, videos, gambling, travel information, and
interactive games are everywhere.
= Even the local theater and television listings can be accessed.
Locate people or businesses.
= For example, just from a phone number, or zip code.
= Or use the white and yellow pages online.
= Even purchase products or groceries online
Obtain maps and directions, if the address or general location is known for the destination.
You can shop, visit cute or inspirational web pages, and even send electronic greeting cards.
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With most of this information free, all you need to be able to use the Internet is a computer with access to
the Internet. This connection can be from work, or a personal connection at home, such as via a telephone
line, television cable, or a satellite TV. This requires you either subscribe to an Internet Service Provider —
ISP, or "borrow" the use of someone else's. There are also free "wireless hot spots" all over; sandwich
chains, coffee spots, even shopping centers and doctors' offices. The ISP will either use normal telephone
lines (DSL and dialup), television cable, or satellite connections all passed through to the computer through
a "modem"; these respective modems connect the computer to the Internet signal. Internet Providers
such as AT&T, Comcast, CenturyLink, or other phone or cable services all offer Internet Service ISP); as
does AOL offer broadband (high speed connection) and dialup (used now only in very remote areas).

e You may have an Internet connection available through a workplace Network Internet Access.

e As mentioned above, you may also share someone else's Internet Service Provider.

Once you have data “streaming” to your computer, you need a software program called a “browser” to
view the (interpret) the data being sent (read text, view pictures, or interact with the Web). Such
browsers include, Microsoft Edge (Windows 10), Internet Explorer (included with all Windows), Google
Chrome, or Firefox to name a few of the more common ones.

e Most Browser software programs necessary for viewing the Internet pages are free: Microsoft Edge
and Internet Explorer (supplied free by Windows), Chrome, Firefox, and AOL (if using their
downloadable software) are the most well-known and used.

e AOL software, as a browser, is somewhat clumsy.

0 Because of that, my suggestion if using AOL desktop software, is use Internet Explorer (or
your browser of choice) for working with the Internet.
0 As an Email program, it is quite easy to use for beginners.

e Remember that an E-mail Program does not view the Internet, though it does require connection

with the Internet.

The Most Common browsers are:
e Microsoft Edge (Supplied with Windows 10)
e Internet Explorer (supplied by Microsoft with Windows)
e Google Chrome
e Mozilla's Firefox (which also offers an Email program, Thunderbird)
e Opera
e America Online desktop 9.x (supplied by America Online as a free download)
e But there are even others.
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Using the Browser
Common Features of a Browser window (Using images from Internet Explorer shown below)
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e The Title Bar lets you know what web page you are viewing, and sometimes with which Brower you
working. It also can contain toolbars

0 Internet Explorer 11 no longer displays a menu bar. To get it back, right-click on the toolbar
and then click on “Menu Bar” (or for temporary display of the classic menu, hit the ALT key).

e The various Toolbars contain buttons which are used to “navigate” web pages, or open features
available with the browser.

0 They can often be customized (decide which buttons you want thus which functions).

0 To customize the main Internet Explorer Toolbar, now referred to as the “Command bar”,
either right-click on the toolbar and choose “Customize Command bar”; or go to the View
menu (of the menu bar if available) and choose “Customize”.

0 Why customize the Toolbar?

= You may have particular functions specifically used by you, and others unneeded.

0 Clicking on a “button” opens something (Favorites (History is now under Favorites), Add to
Favorites, Search, etc.), clicking again on the same button closes it.

e The Address Bar is the line identified by the box containing the current web address. It reads:
“http://www.whateveraddress.com” as an example.

) £ - & [| B Watch TV Online, Pay Your ... *
T A 0 The address box is just to the right of the two arrows (Back and Forward buttons).
0 The Back button returns you the page you were viewing just before the current page.
0 The Forward button returns you to the page you were viewing just before you used (clicked
on) the Back button.
L— 0 The Address box is where you enter the web address you wish to be connected to, such as
obtained from a newspaper or magazine article, an e-mail (“paste into your browser”), or
simply supplied in written form. You can also insert search terms into this box.

0 APADLOCK & appears to the right on this box, as a sign of a secure connection. You want
to see this before putting any personal information, such as credit card numbers, etc.
= On AOL, the lock is at the bottom right. But similarly, look for it for security.
0 Most browsers also now use the Address box as the Search box, into which you can enter
text, then click the “magnifying (or search) glass”.

O The drop-down menu from Tools | File - (the sprocket icon)
allows you find text “on this page”.

Y U - T T = N Print >
Full screen F11 File »
Save as.. Ctrl+5 Foom (100%) >
Find on this page Ctrl+F Safety >
Suggested Sites Add site to Apps

Lo ETE A B View downloads Ctrl+)J



Basics Lesson Five - Internet Essentials
e The Status Bar, which is located at the bottom of the Internet Explorer window, displays

. . - e
information about: i + 100%
| http:/fwww.comcast.net/sports/articles/cbk/2008/03/22/NCAA-Siena-Vanderbilt/ € Internet | Protected Mode: Off 1100% - |

40 Link destinations show there when the link is hovered over (the mouse cursor rests over).
O May supply hints at times
0 Atthe far right, you can use a drop-down or sliding tool to zoom in or out on a page.

Hints
e Remember the browser is a window just like any other, and can be moved or re-sized
0 Except some pop-up windows cannot be resized. They have been fixed a certain size.
0 Also some browser windows are difficult to close (they hide the customary X).
= Don’t click on the window. Many of these pop-ups are designed to take you to their
web page if clicked upon. Go down to the taskbar; find the button for the window
(when you click on it, the pop-up displays over the other windows). Now right-click
that button and choose Close.
= |f all else fails, click on the title bar (if one), then CTRL-SHIFT-ESC (Opens Task
Manager), and End Task on the highlighted Internet Explorer item under the
Applications tab.

e Pop-up Stopping programs prevent pop-ups by preventing a second instance of the browser (IE,
AOL, etc) window from opening. But this can prevent some legitimate pages from working
properly, such as banking, purchasing, and other programs which often use a second window to
display purchasing forms, etc.

0 If you want to use a pop-up blocker, then:
=  Try temporarily disabling this feature (pop-up blocker) in Tools or Settings.
=  Or some browsers allow disabling the pop-up blocker on a use-by-use basis by
holding down the CTRL key before and while clicking a link.

Appearance of the cursor when on a web page
e The cursor on a web page assumes three appearances.

0 Typically, the cursor is an arrow (a pointer), while over buttons, or borders. %

. I
0 When over a link, the cursor becomes a hand. *./
0 When the cursor hovers over text (which can be selected and copied as editable text), it

becomes an I-beam. 1
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Use of the Address Box

n http://my.dfinity.com/?cid=cust L~-c Watch TV Online, Pay Your ...

e C(lick in the address box, and the current address turns blue (selected). Just begin typing into the
box, and the newly typed address replaces the old. You do not need first to backspace through or
delete the old address.

e Most browsers will add automatically the www. (dot). Type only address. and whatever suffix the
domain ends with, and hit the ENTER key. As an example, microsoft.com, or cvicfl.org. If you are
having trouble obtaining the page, try adding the www. (dot). Typing the http:// is never needed.

0 The claim and common practice is you don’t need to type the www.; Internet Explorer and
most browsers will add it; but success at locating the site is unsuccessful, try adding the
www. (www followed by the period mark).

0 With Internet Explorer and other browsers, if it is a .com suffix, just type the main name
(such as microsoft), then while holding down the CTRL key, hitting the ENTER key adds both
the http://www. (at the front) and the .com (at the end). This works only for .com (dot
com), not for (dot) .anything else.

e Once you have typed (or pasted) in the URL (the web address), just hit the ENTER key. Also, when a

http://my.xfinity.com/7cid=cust 0O ~

new address is inserted: the far right “Refresh” button

changes into a “Go arrow” button gl 2 @ .

e Whatis a Link?
0 Alink takes you from the page you are viewing to another area of the same page, another
web page or another web site entirely without typing an address.

0 When you hover over a link, the Cursor becomes a hand “\ﬂj’ .
0 Clicking on that link may do one of several things:
= A new web page may replace the old one in the original window, and the back
button is available to return to the original page.
= The new web page may open in a separate window (remember the pop-up stopper
if nothing happens), while the other window remains available underneath the old.
A click on its button on the Taskbar brings it back on top.
= The new web page may replace the old, with a grayed-out Back button (the prior site
history was erased, thus no going back).
= Or with the “tabbed” viewing of Internet Explorer 7, it may open up a new tab.
0 When you go to a new page via a link, there is sometimes a link on that page allowing you
to return to the previous page; otherwise make use of the BACK button.
0 The conventional color for links is blue, but the web author can dictate different colors.
0 Links conventionally appear as underlined text, or the link becomes underlined when
hovered over with the mouse cursor.
0 Favorites (Internet Explorer), Favorite Places (AOL), or Bookmarks (Chrome, Firefox etc.) are
lists of saved links allowing you to return to a desired web page. You can add to those
Favorites when visiting a site you think you may want to return to (find again easily).

n x o Y

= Click on the staricon
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“Navigation” Buttons
Internet Explorer’s buttons used as example:

6 > http://my.finity.com/?cid=cust JeR ] WatchT‘u‘OnIine, Pay Your ... *

e The Favorites button [af opens a list of previously
saved links. Once you click on a link, the list closes. Add to favorites |+

0 If you wish to keep this list open, click on the .
Favorites Feeds History

“Pin favorites open” button [l ”at the top _ A
right of the Favorites window). 1
andl.com
e “History” brings up a window Pane on the left
revealing the sites you have visited the last few days or weeks.
e The Add to Favorites button (top of Favorites box) allows you to save a page you are currently
viewing to the list of Favorites.

clicked:
0 You can choose to save Add a Favorite
it at the bottom of the M Add this webpage as a favorte. To access your favontes, visit the
Favortes Center.

Favorites list, or within

another folder by Name: bh TV Online, Pay Your Bill, Contral & Secure Your Home —and mnr&!
clicking on “Create in Createin: |l Favortes v || New folder

(or the drop-down

arrow next to Create Cancel

in) to use an already

existing folder. Click on the “New Folder” button to create a folder within the folder
already named in “create in” box.
e Most browsers have a folder labeled Favorites bar (or similar. This can display the most common
favorites for quick access.
e Almost all browsers have “tabbed browsing”. What that means, is you can have several Internet
pages opened, each in a separate tab of the same browser window.

@ http:/fwanw.dell.com/en-us/ L~ '@' Dell Official Site - The Powe... *

_——

O To open a new page in another “tab” by either: Blank tab
= (Click on the blank tab and insert the address desired in the address box; then hit the
ENTER key.

= Hold down the CTRL key (or SHIFT+CTRL keys) while clicking on a link within the
currently viewed page. The new page will open in a tab (CTRL on bottom,
SHIFT+CTRL on top).

= The four-box button to the left of the tabs creates small images of all tabs.
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Again, most browsers also offer a HOME button (appears as a small house icon), to quickly access
the page you want to come up each time the browser is opened.
0 This button may not be displayed automatically, and may need use of "Settings" or
"Internet Options".
0 Home button

= |nternet Explorer

Q
= Google Chrome > C @ b
*  Microsoft Edge K4 O @

= You can typically have one or more home pages which open when the browser first
opens.
= The page(s) set as home page are modified again in Settings or Options.
0 Settings or Internet Options are accessed differently in different browsers.
= |nternet Explorer has "Internet Options" found in the Tools menu displayed in the

"sprocket" icon .

o
= Google Chrome has Settings under the "hamburger menu top right X @
— T a06

el

= Microsoft Edge has Settings under the "ellipsis" menu
= Here you can change several of the appearance features or functionality of the
browser.
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The Address bar is similar to others. The left side contains typical navigation buttons.

| weicome |{ ¢ ][ J{x]{=]{# -

“Previous” and “Next” buttons *_ have the same function as Back and Forward,” Previous”
taking you back to the previous site, and once used, and “Next” returning you to the later site. But
there is no going beyond one back or one forward (no drop-down arrows).

Stop [% and Refresh F] also function the same as Internet Explorer. Stop halts the page loading,
and Refresh reloads (or attempts to reload) the page, thus "refreshing" the data.

There is also a “Home” button (represented the small house m), taking you to a single designated
“home page” set within Settings/Preferences. You can also simply put it in Favorite Places.
Simply typing an address in the Address bar followed by hitting the ENTER key takes you to a

website. You can again click on the Go button. JLIEI

The right half of AOL' Address
toolbar has a search box, and the [ m ifbauontes
Favorites button and drop-down.
0 Favorite Places is the original AOL name for Favorites, and is now labeled Favorites on the
right side of the Address toolbar.
One place where AOL differs from Internet Explorer. AOL does not have all these buttons on the
main toolbar. AOL'users. find another toolbar at the B @A (oo
right of each web site window.
0 To save a Favorite to Favorite Places:
= Navigate to the desired site.
= Click on the Red Heart to the right side of the web page toolbar.

= Click on Add to Favorites.
On AOL, the History shows for the last 300 site

- | Go You have selfected a Fa\raritq? Place. Which
the drop-down arrow next to Go. of the following would you like to do 7

Add buttons for Favorites to AOL’s toolbar.
O It acts as the Favorites bar in Internet Explorer.

clicking

5]

Add to Favorites »
Add to Toolbar

=]

Insert in Mail
Insert in Instant Message

HE

AOL does have a main menu bar and icon bar as well.

Eile Edit Mail MNews Finance Entertainment Lifestyle Community Services Safety Window Keyword SignQOff Help

29
=

= & M B ¢ O @[ ./ @m O @ e

Write M Explore Local News  Settings  AOL Radio  Finance Moviefone PC Checkup MyBenefits @
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How to Print the Entire Web Page

Click on the Sprocket, Ellipsis (three dots), or Hamburger (three horizontal bars) icon usually near
the upper right-hand corner of the window. Then go to Print. Chrome and Microsoft Edge will
then present you with a printer dialog window allowing you to see what you are printing, and how
many pages. On Internet Explorer, choose either Print or Print Preview. If you simply choose Print,
you will not know how many printed pages you get until printing is finished. Print Preview provides
a window similar to Chrome and Edge, allowing you first see how many pages and what you are
printing.

Print only certain (desired) pages by using Print Preview first.

On Internet 3 pri i
Explorerll, the § Print Preview
Print Preview & | Print Preview

window offers ‘ - | | & -5 | l_ﬂ 1Page View ~ | Shrink To Fit ~

several features.
0 Orientation change
0 View full width
0 “Shrink to fit” prevents the right side from being “cut off” if you forget
to change to Landscape orientation.

. . Page Range
Look at each page, then click the Print button (on the 5 Al
Prfewew page) ar.md d(‘eS|gnz?te which pages you wish to ) Selection  © Curent Fage
print. Print Preview is available on AOL 9.x as well.
In Print Preview, if the right side of the page is being cut Pages: 1
. . . . . D Orientatian
off, consider changing the page orientation from Portrait =—'to Landscape

D ] ) &+ Partrajt
(use printer preferences or Options).
" Landscape

How to Selectively Choose Text/and/or Graphics

If you want to print just select text (for instance just a phone number, or address, or phrase) you
hate to waste the ink printing an entire sheet of text or unwanted pictures. To do this, in your
Printer Dialog box click “Selection”. If no choice of “selection” is present you have not yet selected
anything.

1. Select Text by dragging over it from one corner to the opposite diagonal corner.

Any graphics included will also be included in the selection.

2. Copy the selection (Edit/Copy or CTRL-C).

3. Now select "Selection" from the printer to print this.
If the printed text is too small, consider pasting the selection first into a word processor and
enlarging the font size before printing from the word processor.

4. Open Word, Works, or Word Perfect (or even WordPad if only text).

5. Paste the selection copied into the word processor (Edit/Paste or CTRL-V).

6. Now print from the word processor either using File/Print/OK, or click the printer icon.
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How to Save a Picture (Graphic) Found On a Web Page
e Choose the picture you wish to save.
1. Right-click on the picture you have chosen.
2. A menu appears. Click on “Save picture as”.
3. Anew dialog box opens asking where you wish to save it. It usually opens in the (My)
Pictures folder. Navigate to the folder you wish to save the picture in (or create a new one).
4. Give it a descriptive name.
5. Click Save.
e On that right-click menu, you could also choose “Set as background” which makes the picture your
wallpaper (Remember, a small picture may look strange, either centered and tiny or stretched and
distorted).

How to Access Internet Options
e You may need to change options on (customize) Internet Explorer, AOL, or another browser, such
as the home page or security.
0 The home page is that web page which first comes up when you open Internet Explorer.
e To customize your Browser program:

0 For Internet Explorer, go to the Tools menu, sprocket icon and choose

Internet Options.
0 On other browsers, look for the hamburger or ellipsis menu icons.
0 For AOL go to Settings/Preferences/Internet, or the Settings icon *‘?ﬂﬂs on the Main AOL
toolbar.
e Why would you need to customize?
0 Connections may change (you change Internet Providers).
Security settings may need to be adjusted to properly use certain pages.
Privacy/Cookies settings may prevent or allow too much.
You may wish to change the Home (Start) Page.
Turn off the pop-up blocker if interfering with some web site functions.
When pages begin loading slower than usual (or not at all), you may want to try deleting
Temporary Internet Files. It is advisable to do this occasionally anyway.
Clear the History of all sites you recently visited (paranoid or pornography?)
= (Remember copies of all graphics looked at are in Temporary Internet Files as well.)

O O O0OO0OOo

@]
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Similar Important America Online Menu bar Items

Edit Mail Mews Finance Entertainment Lifestyle Community Services

File menu

Mail Saved on My PC (FILING CABINET)
Print Setup

Print Preview

Print

Sign Off menu

Help

Switch Screen Names
Sign Off
0 Becomes a “Sign On” menu when disconnected

About [Program Name] gives the version or product ID
[Program Name] Help provides help for the program

Safety

Window

Keyword

Sign Off

Help

11
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Simple Search Basics
e Most browsers including Internet Explorer use the main address box also as a search box.
O Just type a term you are looking for in the address bar.
0 Ifit keeps wanting to take you directly to a web site, add a question mark (?) to the front or
back of the search terms.
e Also, you can use a Search Engine such as:
0 yahoo.com
msn.com
aol.com
altavista.COM
google.com
Many others

O OO0 0O

Basic Techniques
e If looking for a definite phrase (or multi-worded name), use of quotation marks around the phrase.
0 Example: “to be or not to be”
Include or Exclude certain items by including the words AND, OR, and NOT (must be in caps).
0 Examples: dogs AND cats or dogs NOT cats
e Using + or —signs in front of words also includes (+), or excludes (-).
O Example: +travel +planes -cars
0 Most search engines now assume a plus sign unless specifically given a minus sign.
O Most search engines are also not case sensitive.
= Meaning a capital letter and small case letter are the same.
e Often need to try different words, or combinations of words, or different order of words
0 Even typing “chairs” (the plural) may yield different results from “chair”.
0 Search engines search for the first term listed first, then the second, etcetera.
= So rearranging terms may yield different results.
e All search engines have a description of how to use their service optimally.
e All search engines also have “advanced” search buttons/options.
0 Here you can add or subtract terms, and limit searches in other ways.
e Some search engines also allow you to search within a list of results.
O But that is no different than listing additional words in order.
e Find too many unwanted "hits" (a hit is a search item found), use the minus sign to eliminate sites
relating to unwanted terms.
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